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Lesson 1: Exploring the Access 
Environment 

Lesson Objectives 
In this lesson, you will explore the Access 2013 environment and interface, and learn to use them to create 
new database files, and open and save files. You will also work with the Navigation Pane and export 
databases.  On successful completion of this lesson, you will be comfortable with: 

 defining the function of a database 

 comparing databases in spreadsheets to those 
created in a relational database management system 
(RDBMS) 

 identifying Access file types and file name extensions 

 identifying database objects 

 differentiating between desktop databases and 
Access Web apps 

 identifying the main components of the Access user 
interface 

 identifying elements on the screen  

 creating new blank databases  

 creating databases in older formats 

 creating databases from templates 

 opening and closing databases 

 working with the Navigation Pane 

 saving and exporting databases 

 setting Access options 
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An Introduction to Databases 
Although many people become uncomfortable at the thought of working with a database, a database is 
really nothing more than an organized collection of information. The basic function of a database is to 
store data. If the database is well organized, retrieving the data you want is easy. 

The key to designing and using a database successfully lies in understanding the nature of the data – that 
is, how the pieces of information are related to each other – and understanding how Access stores and 
manipulates the data. 

Databases in Spreadsheets 
Many users are comfortable with spreadsheets, and many databases begin as data entered into a 
spreadsheet. Spreadsheets display rows and columns of data in a table format. It is easy to understand and 
visualize the data in a spreadsheet because all the data is visible and stored in one location.  

A database in Excel is a single table that cannot include any blank rows or columns.  

Consider the scenario of a gardening supply store that needs to track orders. A spreadsheet database 
solution created in Microsoft Excel 2013 might appear as shown in Figure 1-1. 

 
Figure 1-1: Spreadsheet database solution for gardening supply store 

Although it is easy to see and understand the data shown in the spreadsheet, notice that there is 
considerable repetition in the table.  In this database, a single order requires a record for every line item. 
This type of database will take longer and longer to search as it grows. 

Also, the person entering the order information will have to type in the same information (order number, 
customer number, customer name and customer address) many times for a multiple-item order. This is a 
time-consuming process, and opens up many possibilities for error. 
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The large size and repetitive nature of the data reflect the complexities of the data itself. At first thought, 
tracking orders might seem a simple task; but consider how the various pieces of data are related: A 
customer may place one or more orders, each order will consist of one or more line items, and each line 
item must reflect a particular product that is available in inventory. These relationships are quite complex.  

Weaknesses of Spreadsheet Databases 
Even though you can perform complex calculations on data in a spreadsheet, a spreadsheet program itself 
gives you only limited control over the data that is entered, and complex data relationships are difficult (if 
not impossible) to represent.  

Another difficulty with the spreadsheet solution is that the order of the rows in the spreadsheet affects how 
the data can be summarized. For example, the table in Figure 1-1 is currently sorted by order number. 
What if you wanted to see the rows by customer number instead? You would have to sort (that is, 
rearrange) the rows in the spreadsheet.  

If you needed to print a list consisting of only customer names, customer ZIP codes and order totals, you 
would need to reorganize (or extract) the data in the spreadsheet and use a SUM function to calculate each 
order before you could print the desired list. 

Relational Database Management Systems (RDBMS) 
Relational databases are a software solution quite different from spreadsheets. In general, database 
software is referred to as a relational database management system (RDBMS).  A RDBMS allows you to 
define, create and maintain databases while providing controlled access to the data.  

Many database applications are available on the market. Oracle, SQL Server, MySQL and Microsoft Access 
are just a few. These programs offer various features and interfaces, but all of them access stored data in a 
standard manner – through Structured Query Language (SQL). 

Structured Query Language (SQL) is the standard language used to create professional, high-performance 
databases. Once a database has been created, SQL is also used to retrieve and manipulate the data. Any 
interaction among a user, program and database takes place through the use of SQL. 

Multiple, Related Tables 
Unlike spreadsheet databases which store all the information in a single table, relational databases store 
data in multiple tables. In fact, one of the first things you may notice when you open and examine a 
database table is that you are viewing only part of the data. That is because the data is parsed out into 
several related tables. 

Each table in a database stores data about a specific aspect of the information. In the case of the gardening 
supply company, for example, there might be a table that contains customer information, a table that 
contains order information, a table that contains detail information for each order and a table that contains 
product information.  

Each table in a database stores data about a specific type of thing. For example, the customer information 
table described above would store information only about customers; it would not include information 
about orders or inventory.  
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Additionally, and perhaps most importantly, each record in a database table must be unique. The 
customers table may store information about multiple customers, but each customer is entered only once 
in the table. 

Because the data stored in each table is related to data in the other tables of the database, a complete set 
of information can be retrieved. For example, you could retrieve the complete information for a particular 
order from the Customer, Order, OrderItems and InventoryItems tables, as shown in Figure 1-2. 

The shaded rows in the figure show that Order #1 was placed by Helen Anderson (Customer # 1012) on 
2/19/2015. The order includes three line items: one for a garden hose (item #5), one for some rosemary 
seed (item #17) and one for fieldstones for a garden path (item #40). 

 
Figure 1-2: Relational database solution for garden supply store 

Using separate tables is very efficient. Notice that in contrast to the spreadsheet solution, very little data is 
repeated among the tables. Minimizing the repetition of data helps to keep data valid and accurate. 

Even if you are new to databases and they seem a little scary, once you become accustomed to how data is 
stored and presented, you will find they are an easy solution for storing complex data. 

What is Access? 
Microsoft Access 2013 is a RDBMS and a complete application development environment. Unlike other 
RDBMS’s, Access also includes the tools you need to develop user-friendly interfaces and reports. Even if 
you are interested only in setting up databases and managing data, Access provides a user-friendly 
environment that allows you to accomplish database tasks very quickly even without prior database 
knowledge. 
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As you learned earlier, any interaction among a user, program and database takes place through the use of 
SQL. In Access, the actual SQL code that controls and manipulates the data is used behind the scenes; you 
never see the SQL code (unless you want to). Instead, you interact with a graphical environment which 
allows you to create tables, queries, reports and other database objects. 

Access Database File 
An Access database is a container for a variety of database objects; it can contain as few as a single table, 
or a large collection of tables, forms, reports and queries. For example, an order tracking system (such as 
the one discussed earlier) that uses four tables is not four databases; it is one database that includes four 
tables: one for customer information, one for order information, one for order detail information and one 
for product information. 

An Access 2013 database stores its objects in a single file with the .accdb file name extension. (Access 2010 
and 2007 also uses the .accdb file name extension.) Databases created in earlier versions of Access use the 
.mdb file name extension. 

You can open and work with .mdb and .accdb databases in Access 2013. You can also use Access 2013 to 
create new databases and save the databases as .accdb or .mdb files for backward compatibility with earlier 
versions (for example, Access 2000 and Access 2002-2003). 

Database Objects 
An Access database can contain various types of database objects, including tables, queries, forms, reports, 
macros and modules. These database objects are briefly introduced in the following table. Individual types 
of database objects will be discussed in detail in later lessons. 

Tables A table is similar in appearance to a list or spreadsheet. The data is stored in the rows and 
columns of a table datasheet, as shown. 

 
Each row in a table is a record, and each record consists of one or more fields. Fields 
correspond to the columns in the table. In the VENDORS table shown in the figure, each 
record (row) contains information about a different vendor for a garden supply shop, and 
each field (column) contains a different type of information, such as name, address, and 
phone number for each vendor. 
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Forms Commonly used as data entry 

screens, forms are user-friendly 
interfaces for working with the 
underlying table data, and they 
often contain elements and 
command buttons that make 
entering data and performing 
various other tasks quick and 
easy. 

You can manage data without 
using forms by simply editing 
the data in the table datasheets. 

 However, most database users prefer user-friendly forms for viewing, entering, editing and 
deleting data in the underlying table. Forms also enable you to control how users interact 
with the data. For example, you can create a form that shows only certain fields and enables 
only certain operations to be performed. 

Reports You use reports to print and 
summarize data. For 
example, a report such as the 
one shown at the right can 
show the details of orders 
placed within a particular 
time period and include 
totals for individual orders. 
Each report is formatted to 
present the information in the most readable way possible.  

 You can format any report to fit your requirements and you can create custom reports as 
well.  

You can run a report at any time and it will always reflect the current state of the data in the 
database. Generally, you will print reports, but you can also view them on the screen, export 
them to another application, or send them as e-mail messages. 

Queries You use queries to extract subsets of data from one or more tables. A query allows you to 
view data from several tables in a single datasheet. Queries also allow you to view only 
specified fields and add criteria to retrieve only specific records.  

The result of a query is called a record set or result set. You can view the result set on the 
screen, print it, copy it to the clipboard, or use the output of the query as the record source 
for a form or report. 
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Macros Macros are database objects that add functionality and automation to a database. A macro 
contains a series of database actions that are saved in an executable block of simplified 
programming language. Macro actions perform tasks, such as adding, deleting, or printing a 
record; opening a report; running a query; or closing a form. Most database operations that 
you perform manually can be automated by using macros.  For example, you can attach a 
macro to a command button on a form so the macro runs whenever the button is clicked. 
Macros are timesaving devices because they automate database operations. 

Modules Modules, like macros, are database objects that add functionality to a database. Modules are 
written in the Visual Basic for Applications (VBA) programming language. A module is a 
collection of declarations, statements and procedures stored together as a unit. Writing 
modules enables you to create procedures that run complex and intelligent time-saving 
automated operations in a database. 

Note: This course introduces basic and intermediate skills for Access 2013. Not all the database objects 
listed above are covered in this course. 

Desktop Databases and Access Apps 
In previous versions of Access, you could share a database with other users on the web by publishing the 
database to a SharePoint site using Access services. This functionality is built into Access 2013 through 
Access apps. 

An Access app is a new type of database that you create, design and modify in Access 2013, and then use in 
a standard web browser. You share Access apps with other users as SharePoint apps. 

The data and database objects are stored in SQL Server or a Windows Azure SQL Database, so you can 
share the data within your organization using on-premises SharePoint 2013, Office 365 Small Business, or 
Office 365 Enterprise. That is, to create and use an Access app you will need Access 2013 and an Office 365 
site or SharePoint Server 2013. 

To build an Access app, select the type of data you want to track (for example contacts, tasks, or projects), 
and Access creates the database structure for you, including views, navigation and basic commands. You 
can then add and edit data through your browser. 

In contrast, a desktop database is one that you work with on your local system. Alternatively, the Access 
database may be stored on a centralized database server and accessed over your organization’s network. 
Even though this database is not on your local system, you are still using it as a desktop database because 
you are not using Access apps through a web browser. 

In this course, you will work with desktop databases. For information on creating and working with Access 
apps, see What’s new in Access 2013 in the Access Help system. 
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Components of the Access 2013 User 
Interface 

The Microsoft Access 2013 user interface provides the ability to work with a database as a complete file, 
and the ability to work with individual objects within the database. The three main components to the 
Access 2013 user interface are: 

Ribbon A panel of command buttons and icons organized into sets of tabs. The Ribbon 
appears across the top of the program window. Each tab on the ribbon contains groups 
of commands related to specific database tasks. 

Navigation 
Pane 

A pane on the left side of the program window that displays database objects 

Backstage view A collection of options on the File tab of the ribbon. 

The Ribbon 
The Ribbon is a tabbed toolbar that contains the commands and options you use to perform tasks. Each 
tab contains a group of related commands, and each tab relates to a type of activity, such as creating a 
form or working with data in a table. The Access 2013 Ribbon is shown in Figure 1-3 with the Home tab 
selected. 

 
Figure 1-3: The Ribbon  

The Ribbon can help you find the commands you require quickly. Commands are grouped on tabs with 
each tab relating to a type of activity, such as working with records, creating database objects, or importing 
or exporting external data. You can customize the Ribbon to display the commands you use most often in a 
particular order, or to add or remove commands for a Ribbon tab (not covered in this course). 

To reduce screen clutter, some tabs (called contextual tabs) appear only when they are applicable. For 
example, the Table Tools tab (which itself contains two tabs) appears only when a table is open, as shown 
in Figure 1-4. 

 
Figure 1-4: Contextual tab on the Access 2013 Ribbon 

Command button 

Ribbon tabs 

Collapse the 
Ribbon button 

Help button 
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The Ribbon includes the following components: 

Ribbon tabs Relate to a type of activity, such as creating objects in a database, or working with 
external data. You will see contextual tabs when they are applicable; for example, 
you will see the Report Design Tools tab when you open a report in Design View. 

Command buttons  Appear on the ribbon tabs in groups. When you click a command button, an action 
occurs. For example, when you click the Relationships command button, the 
Relationships window appears. 

Collapse the 
Ribbon button 
(CTRL+F1) 

Collapses the Ribbon to just the tab names in order to conserve space on the screen. 
You can still use the Ribbon while it is collapsed – simply click a tab name to expand 
the Ribbon when you need to perform a task. The Ribbon will automatically collapse 
again once you have clicked a button.  You can also press  

+  to toggle between a collapsed and expanded Ribbon. 

Microsoft Access 
Help (F1) button 

Provides access to information and tips about the program’s features. You can enter 
a question using your own words, or you can type in keywords in the Search field to 
display Help topics about which you want to learn more. 

The Ribbon replaces the old menus and toolbars of Access versions previous to 2007. You will work with 
the Ribbon later in this lesson. 

A button that appears in a different color or that has an outline is active; many buttons deactivate when 
you click the same button again or click another choice. For instance, the Bold command can 
be applied to selected text by clicking that button. While active, it has a different color and 
outline. To turn off the boldface, click the same button again. 

Each tab on the Ribbon contains groups with similar commands. For example, the Home tab includes a 
group called Text Formatting, which contains buttons for formatting text characters; and the Database 
Tools tab includes a group with different analysis tools that can be used to analyze tables and 
performance. 

If a group shows a feature with drop-down arrow, 
you can click the drop-down arrow to display a list 
or a gallery of options for that feature. 

 

 

You can click the dialog box launcher button  at the lower right of a group to display a dialog box, 
window, or task pane offering more options for this group of features. 
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 Dialog Box Window/Task Pane 

Using a dialog box, you can change options for the selected feature, click a button to apply the changes, 
then close the dialog box. However, a task pane remains open on the screen so you can make ongoing 
changes; for example, the Office Clipboard task pane shows items that have been cut or copied to the 
clipboard and are available for pasting into one or more database objects. 

You can collapse the Ribbon to conserve space on the screen. To collapse the Ribbon: 

• Use the  button at the far right of the bottom of the Ribbon; or 

• double-click any of the Ribbon tabs; or 

• right-click anywhere on the Ribbon, then click Collapse the Ribbon; or 

• press + . 

To expand a collapsed Ribbon: 

• Click the name of a Ribbon tab, then click the  button at the far right of the bottom of the Ribbon; or 

• double-click the name of any Ribbon tab; or 

• right-click the name of any ribbon tab, then click Collapse the Ribbon; or 

• press + . 
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The Navigation Pane 
Located on the left side of the 
screen, the Navigation Panet is a 
central location from which you can 
create and use any type of 
database object. It replaces the 
Database window found in versions 
of Access previous to 2007. The 
Navigation Pane is shown in Figure 
1-5. 

When you open a database, the 
Navigation Pane is displayed to the 
left of any open database objects or 
the workspace. 

 
Figure 1-5: Navigation Pane 

The Navigation Pane includes the following components: 

Navigation Pane 
menu 

Click the drop-down arrow to open a menu that allows you to specify which objects 
to show. The default selection is All Access Objects. 

Open/Close 
buttons  

Collapses the Navigation Pane so only its Open/Close button and shutter bar display. 
Collapsing the pane provides more space on the screen for working with an object. 
To reopen the Navigation Pane, click its shutter bar.  

Object groups Organizes the objects in a database, allowing you to find what you are looking for. 
Each object group includes an Open/Close button, which you can use to collapse or 
expand the list. 

Database objects  The tables, queries, forms and other objects that exist in the database. By default, 
each object appears in its appropriate group.  

Search box  You can type the name of an object for which you are looking and the objects that 
display in the Navigation Pane are filtered to match the name you enter. 

The Navigation Pane shown in Figure 1-5 shows all the objects in the database and does not display empty 
object groups. That is, the Macros and Modules groups do not appear in the Navigation Pane because the 
database does not contain any of these objects. 

To open an object, double-click it in the Navigation Pane. You can also right-click an object to display a 
shortcut menu. For example, you can right-click a table and specify to open it in Design view. You will work 
with the Navigation Pane later in this lesson. 

Backstage View 
You use Backstage view to create, open, save, print and manage databases. The commands and options 
available here are related to things you can do with a database itself. For example, you can create or open a 
database, encrypt it, assign a password, or repair and compact it. 

In contrast to Backstage view is the Access client view, which you use to work with the objects within a 
database. For example, you use Access client view to create tables, add records, or modify a form. 

Group 
Open/Close  
button 

Database objects 

Open/Close 
button Navigation Pane  

menu 

Object groups 

Search box 
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To access Backstage view, click the File tab on the Ribbon. The Access client view is displayed using any 
Ribbon tab other than the File tab. 

 
Figure 1-6: Access 2013 Backstage view – Info tab 

The tabs/commands that appear in the left panel in Backstage view are described in the following table:   

Info Use this tab to repair and compact a database, and to encrypt a database with a password. (If 
you are working with an app, use this tab to manage connections and create reports from 
online data. 

New Use this tab to create a new database or Access app. 

Open Use this tab to view locations where you have stored files, including cloud locations. 

Save Use this command to save any changes to the database. 

Save As Use this tab to select file formats, save specific database objects, or save a database to 
SharePoint. 

Print Use this tab to print records, forms, reports and so on. 

Close Use this command to close the open database, but leave Access open. 

Account Use this tab to connect services and storage locations to your Office account, update your 
profile, change your photo or sign out. 

Options Use this command to open the Access Options dialog box (which you will explore later in this 
lesson). 

Access can also be configured to display quick links to the four (can be changed up to 25) most recently 
used database files below the Options tab in Backstage view. 

To view the application window and Ribbon again, click   at the top of the left panel. 
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Looking at the Screen 
Aside from the Ribbon, the Navigation Pane and Backstage view, several other components appear on the 
screen at various times as you work in an Access database. These components are shown in Figure 1-7. 

 
Figure 1-7: The Access Application window 

The screen includes the following components: 

Title bar Lists the name of the open file and its path. 

Quick Access 
Toolbar 

Provides quick access to frequently used commands. By default, the Access Quick 
Access Toolbar contains the Save, Undo and Redo commands and the Customize 
Quick Access Toolbar button; you can easily customize the toolbar to contain 
commands and macros you use regularly. 

Minimize, 
Restore/Maximize 
and Close buttons 

Enable you to minimize the program to a button on the taskbar, maximize the 
window to full screen, restore the window to its former size, and close the 
application.  

Office Account You can sign in to Office if you want to be able to save your files online to a 
SkyDrive account. Themes and settings are also saved online. Signing in is 
optional. 

Dialog box 
launchers 

Some of the groups in a tab contain a dialog box launcher, a diagonal arrow to the 
right of the group name, which provides quick access to a dialog box with more 
commands or options. You can click the dialog box launcher button to display a 
dialog box, window or task pane offering more options for this group of features. 

  

View Buttons 

Access Work Area Navigation Pane 

Quick Access Toolbar Title Bar Minimize, Restore/Maximize, Close Buttons 

Search Filter 

Navigation Buttons 

Split Bar 

Close Object Button 

Dialog Box  
Launcher 

Status bar 

 

Office Account 
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Close object 
button  

Closes the active object in the work area. You can have several objects open at the 
same time, but only one object can be active at any given time. In Figure 1-7, the 
active object is the Table1 table. 

Access Work Area When you open database objects, they appear in the Access work area so you can 
work with them. 

View buttons  Enable you to switch between alternate views of the currently selected object, such 
as between Datasheet View and Design View. 

Status bar Indicates the currently displayed view (in 
Figure 1-7, the current view is Datasheet View) 
and whether specific modes are applied. You can 
right-click the status bar to show or hide 
elements on the status bar. 

 
Split bar Drag this bar to increase or decrease the size of the Navigation Pane, or to increase 

or decrease the size of the object you are working with in the work area. 

Navigation 
buttons 

Enable you to move among the records in a table or form. The first button moves 
you to the first record; the second button moves you to the previous record; the 
third button moves you to the next record; the fourth button moves you to the last 
record; and the last button creates a new blank record. 

Filter Enables you to remove or re-apply a filter. 

Search Enables you to search and find characters in the table records. 

Viewing Screen Tips 
ScreenTips help identify buttons or elements on the tabs of the Ribbon and the screen. To view a 
ScreenTip, position the mouse cursor over the item. A tip then displays the name of the button along with a 
description of its purpose. For some items, a keyboard shortcut may also display as an alternative way to 
activate this feature. 
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Using the Quick Access Toolbar 
The Quick Access Toolbar, at the left of the title bar above the Ribbon, 
includes buttons for frequently used commands. By default, this toolbar 
contains the Access control icon, and the Save, Undo, Redo and 
Customize Quick Access Toolbar buttons. Use the last button to 
customize or display commands you use frequently, such as new, open 
or print preview.  

 

Starting Access and Working with Database 
Files 
Objective 1.1 

To start Access in Windows 7 and earlier versions, click Start, All Programs, Microsoft Office 2013, Access 
2013. To start Access in Windows 8 click or tap the Access 2013 icon in the Desktop, All Apps, or Start 
screen. If necessary, Windows 8 will switch to the Desktop and launch Access from there. 

Unlike other Office applications which open a blank new file when you launch them, Access presents a 
startup screen so that you can open or create a database. The Access startup screen (Figure 1-8) is divided 
into two panes; the left pane displays links to files you have recently worked with (if any), and the right 
pane displays a gallery of templates you can use to create a new app or desktop database file. 

 
Figure 1-8: Access startup screen 

As you begin to work with database files, these files appear in the Recent list in the Access startup screen in 
subsequent Access sessions. 

 Access  
 Control 
 icon Undo Redo 

 Save Customize Quick 
  Access Toolbar 

 

3255-1 v1.00 © CCI Learning Solutions Inc.  15 

Fo
r E

va
luati

on O
nly



Lesson 1 Exploring the Access Environment 

 

Database Wizards 
Versions of Access prior to Access 2007 included a Database Wizard, which guided the user through a 
semi-automated process of creating a database file. The Database Wizard is no longer supported; however, 
modern versions of Access include several wizards for creating particular database objects (queries, forms, 
reports), and you will be introduced to these object wizards at appropriate places in the course. 

Templates 
All new databases are created from database templates. Templates enable you to 
create new databases quickly. A template is a model or boilerplate of a typical 
database that contains all the table, query, form and report objects required to 
perform a specific function. For example, templates are available to track assets or 
inventory, manage tasks or contacts, and administer projects. 

The template gallery appears on the Access startup screen and on the New tab of 
Backstage view. Any template that displays a globe icon will create an Access app. Templates that do not 
display a globe icon create desktop databases. 

Access 2013 ships with several database and app templates, and provides quick links to templates on the 
Office.com Web site as well. Some templates include sample data. 

Click the template you want to use. Access opens a dialog box that includes a description of the database 
the template will create. The dialog box also includes fields and links which you can use to specify the name 
and location for the new database. 

 

Creating a New Blank Database 
The Blank desktop database template creates an empty database file; that is, it creates a database that does 
not contain any database objects. 
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To create a new blank database, click Blank desktop database in the template gallery on either the startup 
screen or the New tab of Backstage view. Access opens a dialog box and suggests a name 
(Databasex.accdb) and location (the Documents folder) for the new database file. 

 

You can specify your own name for the database in the File Name box. You can also click the Browse for a 
location to put your database button  to specify where you want to save your database file. When you 
click this button, the File New Database dialog box opens, as shown in Figure 1-9. 

 
Figure 1-9: File New Database dialog box 

You use this dialog box to navigate to where you want to save a new database file. You navigate the 
directory tree in the dialog box as you would in any Windows screen. Once you have specified the desired 
location, select the text in the File name box, type a name for the new database and click OK. 

When choosing a name, consider the following: 

• The file name can be a maximum of 255 characters (including the drive and folder path), and may not 
include these characters: / \ : * ? “ < > |  

• Give the file a name that will help you identify its contents quickly. 
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• Access automatically assigns the .accdb file name extension. (The default database type for Access 

2013 is the Microsoft Access 2007 – 2013 Database.) You need to type only the name for the database. 

Creating Databases in Older Formats 
Access 2013 can open and manipulate databases saved in the older .mdb format used by Access 2000, 
2002 and 2003; however, users with these older versions cannot open databases saved in the new .accdb 
format. If you need to create a database that must be compatible with one of these earlier versions of the 
software, you should save the database file in the old format. 

• To save a database in one of these older file types, such as an Access 2003 .mdb file, display the Save 
as type drop-down list in the File New Database dialog box and select the appropriate file format. 

  

• When you are finished specifying a name and location, click the Create button to create the database. 

Creating a Database from a Template 
To create a database that contains ready-to-use objects, click a template in the gallery. If you do not see 
the template you want, click a link in the Suggested searches area, or type a keyword in the Search box and 
click  to locate templates online. 

 

Click options in the Category list box to refine your search. Click the template you want to use, specify a 
name and location and then click Create to create the new database. Once you have created a database 
based on a template, you can enter data and customize the database to meet your requirements.  
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Closing a Database 
When you have finished working with a database, you can close the database and still keep Access open to 
work with other databases. To close a database you use the Close command in Backstage view.  

 

Learn the Skill 
In this exercise, you will start Access and create, save and close databases. 

Note: You will save all database files created for this course in the 3255 Student Files\CreatedFiles folder on 
the Desktop. It is assumed that you will add your first and last names to the end of every file name. 

1 Click Start, All Programs, Microsoft Office 2013, Access 2013. Access displays the startup screen. 

First, you will create a new blank database. 

2 Click Blank desktop database in the templates gallery, then click  to open the File New Database 
dialog box. 

3 Navigate to the 3255 Student Files folder on the Desktop, then into the CreatedFiles subfolder. 

4 Click in the File name box to select the suggested file name, type: Database1- then type your <first 
name> and <last name> (without spaces). For example, if your name were Ann Smith, the file name you 
type in the File Name box would be Database1-AnnSmith. 

5 Click OK to save your specifications. The new file name and file location should display in the Blank 
desktop database dialog box. 

6 Click the Create button to save the blank database in the specified location. Access saves the database 
and opens a blank datasheet with the suggested name Table1 on the datasheet tab.  

  
 Notice that Table1 appears in the Table objects list in the Navigation Pane. If you save the table, it will 

be saved as a database object. (You will not save the table at this time.) 

7 Right-click the Table1 tab, then select Close from the shortcut menu to close the Table1 table. 

8 In the Ribbon, click the File tab to access Backstage view, then click Open in the left pane. Notice that 
the current database appears at the top of the Recent files list. 

9 In the left pane, click the Close command to close the database. 

Next, you will create a database from a template. 

10 Click the File tab on the Ribbon to access Backstage view. If necessary, select the New tab in Backstage 
view to view the template gallery. The majority of templates are for apps. 

11 In the Suggested searches area, click Sales to locate online templates associated with tracking sales. 
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12 Click the Home button to the left of the Search box to return to the gallery. 

13 In the Suggested searches area, click Inventory to locate online templates associated with tracking 
inventory. 

14 Click the Desktop home inventory template to select it. 

15 In the dialog box that opens, click , navigate to the 3255 Student Files folder on the Desktop, then 
into the CreatedFiles subfolder. 

16 Click in the File Name box and change the suggested file name to Inventory-YourName, then click OK 
to save your specifications. 

17 Click the Create button to create the new Inventory database. Access creates and opens the new 
database in Access client view and displays a security warning (depending on your security settings) 
below the Ribbon. 

  

18 Click in the Security warning hyperlink (“Some active content….Click for more details”) to display 
details. Access switches to Backstage view and indicates that macros in the new database have been 
disabled for safety reasons. 

  

19 Click  to return to Access client view. 

20 In the security warning, click Enable Content so you can work with the database objects. 

21 Click the File tab to return to Backstage view, then click Close to close the database. 

22 Click the Minimize button at the upper-right corner of the Access window. You will keep the Access 
window minimized when you are not performing exercises. 

Opening an Existing Database 
As you begin to use Access, recently used database files will display in the Recent list in the Startup screen 
and on the Open tab of Backstage view. You can specify the number of files to display in the list to a 
number between 0 and 50 (inclusive). To open a database that appears in the list, simply click the database 
name. 
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Access can also be configured to provide quick access links to up to 25 databases at the bottom of the left 
panel in Backstage view, enabling quick access to these databases from any tab in Backstage view. Click a 
quick access link to open the database. 

You can also click the Open tab to open a database. 

 
Figure 1-10: Open tab of Backstage view 

The Open tab is arranged in three sections. The left section shows the tabs of Backstage view; the middle 
section displays various storage locations connected to the system; and the right section lists the files 
located in the currently selected storage location. Click a database file to open it. 

When you select a storage location other than the Recent file list, you may see icons for folders and/or a 
Browse button. 

 

Clicking a folder icon or the Browse button opens the Open dialog box, which should be familiar to anyone 
who has used a Microsoft application. 
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You can click the folders in the dialog box to navigate the directory tree on the computer. When you locate 
the file you want, you can double-click the file name or click the file name and then click the Open button. 

You can work with only one database at a time in Access. If you open a database and then open a second 
database, the first database will automatically close. To work with two open databases, you must start 
separate sessions of Access and work with one database in each session. In the vast majority of situations, 
you will work with only one database at a time. 

 

Learn the Skill 
In this exercise, you will open databases. 

1 Restore the Access window. There should be no database open. 

2 Click the File tab on the Ribbon to access Backstage view, then click the Open tab. Notice that the two 
files you created in the previous exercise appear in the Recent file list. 

3 Click the Inventory file to open it. Notice that file opens without displaying a security warning. Once 
you click the Enable Content command, you will not be prompted again when opening the Inventory 
database. 

4 Close the Inventory database file, then return to the Open tab in Backstage view. 

5 In the middle section, click Computer to show a list of recent folders in the right section. 

6 Click the Browse button to open the Open dialog box, navigate to the Desktop\3255 Student 
Files\Lesson1 folder, then double-click HomeGrownSample to open the HomeGrownSample database 
file. (For now, ignore the Security Warning message that displays.) 

7 Click the File tab, then click Close. 

8 Click File, click Open, then click HomeGrownSample in the Recent files list to re-open the database. 

9 Click Enable Content in the security warning, then minimize the Access window. 
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Using the Navigation Pane 
Objective 1.3, 2.2, 3.1, 3.2, 4.1, 5.1 

When a database is open, you work with it in Access client view. In the client view, the Navigation 
Pane is the central location from which you can create and use any type of database object.  

You can resize the Navigation Pane by dragging its right border, or you can click the shutter bar (or 
press ) to collapse or expand it. The collapsed Navigation Pane appears as a thin column along 
the left edge of the window. 

 

You can control which objects display and you can use the Navigation Pane to copy, rename or 
delete objects. You can also set specific options for how the Navigation Pane functions. 

Viewing Objects 
You can control which objects display in the Navigation Pane by selecting options in the Navigation 
Pane menu. To access the menu, click the drop-down arrow. The Navigation Pane menu is shown in 
Figure 1-11. 

 
Figure 1-11: Navigation Pane menu 

You can also control how objects appear in the Navigation Pane. You can view database objects by Details, 
Icon, or List name. List is the default setting. 

 
  

To change the way objects display, right-click the Navigation Pane and select Details, Icon or List from the 
shortcut menu. 
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Sorting and Filtering Objects 
By default, database objects display by object type and all objects appear in the pane. You can display 
objects by creation date or date of last modification. You can also view tables and all their related objects 
(such as queries or forms based on the table). 

You can also filter which objects display in the Navigation Pane. That is, you can view only tables or only 
forms by selecting an item in the Filter By Group list. 

Sorting and filtering database objects in the Navigation Pane can be useful in large databases. To sort, 
right-click the object group heading, point to Sort By, then select an option in the shortcut menu. Notice 
that you can sort by Name, Type, Created Date or Modified Date. 

 

You can specify to show only one type of object. For example, you can right-click the Tables group heading 
and select Show Only Tables to hide the other types of objects.  

You can also hide a particular type of object. For example, you can right-click the Queries group heading 
and select Hide. 

You can also hide individual database objects by right-clicking an object and selecting Hide in this Group. 

Copying Objects 
You can copy an object in the Navigation Pane by right-clicking it and selecting the Copy command from 
the shortcut menu. To paste a copied object, right-click in a blank area of the Navigation Pane and select 
Paste to open the Paste <object> As dialog box. 

 
Different objects have different options. When you copy and paste a table, you can specify to paste the 
structure only or both the structure and the data. You can also elect to add the records in the copied table 
to another table in the database. 
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Renaming Objects 
Renaming objects in the Navigation Pane is as simple as right-clicking the object and selecting Rename in 
the shortcut menu. The object name is then opened for editing in the Navigation Pane. Type a new name 
and press . 

You should take care when renaming objects, as other objects that reference a renamed object may cease 
to function. The default options for Access permit the application to perform Name AutoCorrect, which is a 
feature that keeps track of name changes made to objects in the database and automatically corrects 
(updates) references to the renamed objects in reports, forms and queries. For example, if you create a 
table and a report based on the table, and later rename the table, the Name AutoCorrect feature will 
automatically update the reference to the table name in the report. However, the Name AutoCorrect 
feature does not always catch name changes, and in some cases makes unwanted changes. Many users 
turn this feature off. Name AutoCorrect does not make changes in macros or modules. 

Deleting Objects 
To delete a database object, select the object in the Navigation Pane, then press the  key or click the 
Delete button in the Home tab on the Ribbon. You can also right-click an object in the Navigation Pane 
and select Delete in the shortcut menu. Regardless of which method you use, you will be prompted to 
confirm the deletion. You need to be careful when deleting any object in the database; any other object 
that references the deleted object will cease to function until you remove the references to the deleted 
object. 

Setting Navigation Options 
You can also create custom categories and groups and set options that control how objects display in the 
Navigation Pane. Creating custom groups is advantageous if a database contains a large number of 
objects. Custom groups can make it easy to find the particular objects you want. 

For example, in the HomeGrownSample database, the CUSTOMERS, INVENTORYITEMS, ORDERSTATUSES 
and VENDORS tables contain data that is meaningful without needing to reference other tables in the 
database. These tables can stand alone. Conversely, the ORDERS and ORDERITEMS tables are dependent 
upon other tables for their meaning. You could create a custom category to show standalone objects apart 
from other objects in the database. 

To create a custom category, right-click the Navigation Pane menu bar, then select Navigation Options to 
open the Navigation Options dialog box, shown in Figure 1-12. 
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Figure 1-12: Navigation Options dialog box 

Click the Add Item button to create a new category, type a name for the new category, such as 
Standalones, and press . Next, click the Add Group button, type a name for the new group, such as 
Items, and press . Click OK to close the Navigation Options dialog box. 

Display the Navigation Pane menu and select the new Standalones category. The new category displays 
two groups – Items and Unassigned. To add standalone items to the custom Items group, simply drag 
them from the Unassigned Objects list into the Items list, as shown in Figure 1-13. 

 
Figure 1-13: Custom category and group 
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Learn the Skill 
In this exercise, you will work with database objects in the Navigation Pane. 

First, you will view and open objects. 

1 Restore the Access window. The HomeGrownSample database should be open. 

2 At the left edge of the window, click the Navigation Pane shutter bar to close the Navigation Pane and 
enlarge the work space. 

3 At the left edge of the window, click the Navigation Pane to open it again. 

4 In the Navigation Pane, double-click CUSTOMERS in the Table objects list to open the table. 

5 In the Navigation Pane, double-click VENDORS in the Table objects list to open the table. Both tables 
are open, each in a separate tab in the work area. 

6 Right-click the VENDORS table tab, then select Close to close the table. 

7 At the upper-right corner of the workspace area, click the Close object button to close the 
CUSTOMERS table. 

8 Observe the objects in the Navigation Pane. They are currently grouped by object type. 

9 Open the Navigation Pane menu, ensure that All Access Objects is selected under the Filter By Group 
heading, then select Tables and Related Views. Notice that now the objects are shown in a different 
order. Each table constitutes one group, and each group lists the queries, forms and reports associated 
with the table. Notice that several objects appear multiple times in the Navigation Pane because they 
are related to more than one table. 

10 Open the Navigation Pane menu and select Object Type to return the list to its original configuration. 

11 Right-click an empty area in the Navigation Pane, point to View By, then click Details to view summary 
information about each object. 

12 Right-click an empty area in the Navigation Pane, point to View By, then click List to return to the 
default view. 

13 Open the Navigation Pane menu, and, under the Filter By Group heading, select Forms to filter the 
objects that display in the pane. Only the database forms appear in the pane. 

14 Open the Navigation Pane menu and under the Filter By Group heading, select All Access Objects to 
return the list to its original configuration. 

Next, hide an individual form. 

15 In the Navigation Pane, in the Forms group, right-click CustomerOrders, then click Hide in this Group 
in the shortcut menu to hide the form. (The form has not been deleted from the database; it is merely 
hidden.) 

Now, hide the Forms group. 

16 In the Navigation Pane, right-click the Forms group heading, then select Hide in the shortcut menu. 

Redisplay the hidden objects. 
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17 Right-click an empty area in the Navigation Pane, then click Navigation Options to open the 

Navigation Options dialog box. 

18 In the Display Options section at the bottom of the dialog box, select the check box for Show Hidden 
Objects, then click OK. The hidden Forms group (and the CustomerOrders form) now displays in 
dimmed text in the Navigation Pane. 

19 Right-click the dimmed Forms group header, then select Unhide in the shortcut menu. The Forms 
group displays in dark text, and the hidden CustomerOrders form displays in dimmed text. 

20 Right-click the CustomerOrders form, then select Unhide in this Group in the shortcut menu to 
redisplay the hidden form. 

21 Display the Navigation Options dialog box again, clear the Show Hidden Objects check box, then click 
OK. 

Copy and paste a few objects. 

22 In the Navigation Pane, right-click CUSTOMERS, then select Copy in the shortcut menu to copy the 
CUSTOMERS table to the Clipboard. 

23 Right-click in a blank area in the Navigation Pane, then select Paste to open the Paste Table As dialog 
box. 

24 In the Table Name box, type: Customers2, then click OK. Access creates a new table named Customers2 
which contains the same structure and data as the CUSTOMERS table. 

25 Double-click Customers2 in the Navigation Pane to view the 14 records of data, then close the 
Customers2 table. 

26 Open the RepeatedCustomers table to verify that it is empty, then close the table. 

27 Right-click in a blank area in the Navigation Pane (a copy of the CUSTOMERS table is still residing in 
the Clipboard), then select Paste. 

28 In the Table Name box, type: RepeatedCustomers, in the Paste Options section, select w Data to 
Existing Table, then click OK. Instead of overwriting the table, this option pastes the records from the 
copied table into the RepeatedCustomers table. 

29 Open the RepeatedCustomers table to view the 14 records that were added in the Paste operation, 
then close the table. 

30 In the Tables group, right-click RepeatedCustomers, then select Rename in the shortcut menu. 

31 Type: DuplicateCustomers, then press  to rename the table. 

32 Right-click DuplicateCustomers in the Navigation Pane, select Delete in the shortcut menu, then click 
Yes to confirm the deletion. 

33 In the Tables group, click Customers2, press the Delete key, then click Yes to confirm the deletion. 

34 Close the HomeGrownSample database and minimize the Access window. 
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Saving and Exporting Databases 
Objective 1.5 

When you first create a database, you enter the file name in the File Name box. It is not necessary to save 
the database file after you have given the database a file name. As you work in the database, you will save 
the individual database objects. Whenever anyone adds, modifies, or deletes data, Access will save these 
changes to disk immediately. 

However, you can use the options on the Save As tab in Backstage view  if you want to save the database 
with a different file name or save it in a different location. 

 

Notice the options under file types: you can use this tab to save a database or a database object. These 
commands are accessible in Backstage view when a database file is open. If a database object (such as a 
table or form) is open, the Save Object As option is accessible. If no objects are open, this option appears 
dimmed. 

When Save Database As is selected, you can: 

• Select a database file type 

– Access Database – this option allows you to select a new location and/or name, and maintain the 
Access 2007 - 2013 file format 

– Access 2002-2003 Database – this option allows you to select a new location and/or name, and 
save the database in the Access 2002-2003 file format 

– Access 2000 Database – this option allows you to select a new location and/or name, and save the 
database in the Access 2000 file format 

– Template – this option allows you to create a new database template from the current database 

• Select an advanced operation 

– Package and Sign – this option allows you to digitally sign and package a database file into an 
Access Deployment (.accdc) file for distribution to other users 

– Make ACCDE – this option allows you to save the database as an executable file 
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– Back Up Database – this option creates and saves a copy of the database with the current date 

tacked on to the file name for reference. 

– SharePoint – this option allows you to save the database to a SharePoint server (assuming you 
have appropriate permissions on the server) 

Saving Databases to Different Locations 
To save a database in a different location, select one of the Database File Types, then click the Save As 
button to open the Save As dialog box. 

 
Navigate to the desired location on your machine, an external drive, or a network folder (optionally, type a 
new name), then click Save. 

Saving Databases to External Locations 
If you have cloud storage locations, such as a SkyDrive account or a personal site on your organization’s 
SharePoint site, you can use the Save As dialog box to navigate to those locations as well. 
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Saving Databases to SharePoint 

You can also save an Access database to a SharePoint Server, where they can be accessed through a Web 
browser. Saving to a SharePoint server requires a user account with appropriate permissions on the server. 

 

Saving a Database as a Template 
You have already learned that Access provides built-in and online database templates that allow you to 
create entire database structures with the click of a button. Databases generated from templates include 
tables, queries, forms, reports, macros and modules. Some even include sample data. 

Additionally, you can save a database as a template using the commands on the Save As tab. User-defined 
templates appear in the Personal section of the templates gallery. 

Select Template in the Database File Types section, then click the Save As button to open the Create New 
Template from This Database dialog box. 
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Enter a name and an optional description for the template. You can also specify to use an optional form in 
the database as an instantiation form. 

An instantiation form displays when the database is first created, but it is not saved as a database object. 
Once you close the form, it is deleted. This type of form may be as simple as displaying your company logo 
or may perform some setup code required by the new database. 

If you want to include pre-populated data in the template, click the Include Data in Template check box. 

 

Learn the Skill 
In this exercise, you will save a database as a template, and use the template to create a new 
database 

1 Restore the Access window. 

2 Open the Desktop\3255 Student Files\Lesson1\GS-Generic.accdb database and enable the content. This 
database includes all the tables required for a Garden Shop franchise to start tracking orders. The 
Products, Vendors and OrderStatuses tables are populated with data. The remaining tables are empty. 
Assuming that each new franchise opens with a set inventory, the franchisee need only enter the 
customer and order information. 

3 In the Forms group in the Navigation Pane, double-click Welcome to open the Welcome form. This 
form will appear when you use the template to create a new database. 

4 Close the form. 

5 Switch to Backstage view, then click the Save As tab. 

6 In the Save Database As section, click Template. 

7 Click the Save As button to open the Create New Template from This Database dialog box. 

8 In the Name field, type: NewGardenShop. 

9 In the Description field, type: Set up a new Garden Shop franchise. 

10 Display the Instantiation Form drop-down list, then select Welcome. 

11 Click the Include Data in Template check box.  

12 Click OK, then close the message box that appears. 

13 Close the database, then display the New tab in Backstage view. Notice that there are now two 
categories of templates listed below the Suggested searches area: Featured and Personal. 

14 Click Personal to view the templates you created. 

15 Click the NewGardenShop template to open a dialog box in which you can specify a name and 
location for the new database. Notice that the description you added appears in the dialog box. 

16 Type MyGarden-<your name> in the File Name box, click , navigate to the CreatedFiles subfolder in the 
Desktop\3255 Student Files folder, then click OK. 

17 Click Create to create a new database from the template. 

18 Access creates the database and may display the following message box. 
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19 If necessary, click Yes to display the form. The database opens and displays the Welcome form. 

20 Close the form. Once the form closes, it is removed from the database. 

21 Enable the content, then in the Tables group, double-click Products, double-click Vendors, and 
double-click OrderStatuses to open the tables. Notice that each of these tables contain records. 

22 Right-click the tab of any one of the open tables, then select Close All to close them. 

23 Open the Customers, OrderItems and Orders tables. Notice that these do not contain any records.   

24 Close the open tables, then close the MyGarden database. 

25 Minimize the Access window. 

Access 2013 and Backward Compatibility 
Change comes slowly to many users and to most organizations. You may work with people who are using 
versions of Access that are several iterations older than what you are using. And while you can open and 
work with older database files, there are several points to take into consideration when deciding how to 
proceed. 

Types of Files Access 2013 Can Open 
Although Access 2013 uses .accdb as its native file format, you can use databases from previous versions of 
Access with some of the following limitations.  

Databases created in Access 2000, 2002 and 2003 relied on the Database window for file management. The 
Database window has been replaced with the Navigation Pane. When you open database objects in a .mdb 
file, each opens in its own window, instead of in a tab in the workspace. The difficulty with this scenario is 
that windows can overlap, and objects can hide each other. You can, however, set options for the database 
that will allow it to use workspace tabs. (See Setting Access Options later in this lesson.) 

Many older databases used switchboards (special Access forms) as welcome screens that provide quick 
access to various database objects. Switchboards are partially supported; you can open a database that 
includes a switchboard, and parts of the switchboard that open forms or reports will still function. However, 
any switchboard process tied to the old database window will not function (in modern versions of Access 
they have been largely replaced by navigation forms), and there is no Switchboard wizard in Access 2013.   

Access 2013 can manipulate data created in Access 97; however, you cannot change forms or reports 
unless you save the database in the .accdb file format. 

Converting Older files to the New Format 
To convert an Access 2000, 2002 or 2003 database to the new format, open the file in Access 2013, then 
save it as an .accdb file. Keep in mind that converting to this format obligates the user to commit to Access 
2007 or later to work with the converted database file. 
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To convert an Access 97 file to the new format, you must first open it in Access 2003 and use the 
conversion utility to convert the file to Access 2002-2003 format. Then you can open the converted file in 
Access 2013 and save it as an Access 2013 file. 

Saving Access 2013 files to an Older Format 
To save an Access 2013 database to a different version of Access, for example, to save an Access 2013 
.accdb file as an Access 2003 .mdb file, you use the commands and options on the Save As tab.  

Select either Access 2002-2003 Database or Access 2000 Database in the Save Database As section, then 
click the Save As button to open the Save As dialog box. Specify a name and location, and click Save. 

Exporting Data to Alternate Formats 
Access 2013 is a versatile application; it can work with data created and stored in several different formats. 
You can easily import data from and export data to a wide variety of file types. 

To export an Access object, click the object in the Navigation Pane, then click a command in the Export 
group on the External Data tab of the Ribbon. 

 

Each export operation utilizes a database wizard that allows you to specify a name and location for the 
exported file. In some cases, you can also specify a destination file format (such as a particular version of 
Excel), and whether to include formatting and layout information. 

You can export data from tables and queries as well as from forms and reports. Target file formats include: 

• Excel – exports the selected object to an Excel spreadsheet 

• Text File – exports the selected object to a text file 

• XML – exports the selected object to an XML file 

• PDF or XPS – exports the selected object to a PDF or XPS document, which is useful for sharing data 
without allowing other people to change it 

• Email – exports the selected object in one of several formats (Excel, HTML, PDF, XPS, rich text or text 
file), and attaches the exported file to an email message 

• Access – exports the selected object to another Access database 

• Word Merge – allows you to specify a table or query as the data source for the Mail Merge Wizard in 
Microsoft Word. Not available for forms or reports 

• Word (listed under More) – exports the selected object using the rich text format. which can be 
opened by most word processing software including Word 

• SharePoint List (listed under More) – exports the selected object to SharePoint as a list. Not available 
for forms or reports. 
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• ODBC Database (listed under More) – creates a link for ODBC (Open Database Connectivity) 
databases to extract data on demand; ODBC-compliant databases include Access, SQL Server, MySQL, 
IBM DB2, and Oracle. Not available for forms or reports. 

• HTML Document (listed under More) – exports the selected object to an HTML document. 

 

Learn the Skill 
In this exercise, you will export data. 

1 Restore the Access window. 

2 Open the Desktop\3255 Student Files\Lesson1\HomeGrownSample database once more. 

3 In the Navigation Pane, in the Tables group, click CUSTOMERS to select the table. 

4 In the Ribbon, click External Data, then in the Export group, click Excel to start the wizard. 

5 In the wizard, click the Browse button and navigate to the CreatedFiles subfolder. 

6 In the wizard, display the Save as type drop-down list. Notice that you can export the data as an Excel 
workbook, an Excel binary workbook, an Excel 5.0/95 workbook or an Excel 97 – 2003 workbook. Click 
Excel Workbook, then click Save. 

7 In the wizard, select the Export data with formatting and layout check box. 

8 Select the Open the destination file after the export operation is complete check box. 

  
9 Click OK to export the data and open the Excel workbook. 

10 Close the workbook and exit Excel. 

11 As the last step of the export wizard, Access prompts you to save the export steps. If you perform a 
particular export operation on a regular basis, you can save the steps as a named procedure that you 
can access by clicking the Saved Exports button in the Ribbon. Click Close to end the wizard without 
saving the steps. 

12 In the Navigation Pane, in the Reports group, click Orders to select the report. 

13 In the Ribbon, click External Data, then in the Export group, click PDF or XPS to start the wizard. 
Access opens the Publish as PDF or XPS dialog box. 
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14 In the dialog box, navigate to the CreatedFiles subfolder if necessary, ensure that PDF displays in the 

Save as type box, ensure that Open file after publishing is selected, then click Publish. 

15 If Access displays a message box about the width of the report, click OK. Access exports the report to a 
PDF and opens the PDF. 

  

16 Close the PDF, then click Close to end the wizard without saving the export steps. 

17 Minimize the Access window. 

Setting Access Options 
You can set options that affect how a particular database functions as well as options that affect how 
Access functions. These options are set in the Access Options dialog box. The Access Options dialog box 
includes 11 tabs, which are briefly described here: 

General Contains options for working with Access, such as the default file format for new 
databases and default file locations. 

Current 
Database  

Contains options that allow you to control how a user can interact with the current 
database. These options include enabling various views, showing or hiding the 
Navigation Pane, and whether or not to allow full menus. These options are set 
separately for each database. 

Datasheet  Contains options that affect the appearance of datasheets in Access. The default view 
for tables and queries is Datasheet view. 

Object 
Designers 

Contains options that control how object designers function in Access. Object 
designers (which you will use in upcoming lessons) are the tools you use to create 
tables, queries, forms, and so on. Settings include default field type, default field size 
and error-checking options. 

Proofing Contains settings for AutoCorrect and the spelling checker. 

Language Contains settings that allow you to specify default editing, display and Help languages. 

Client Settings Contains settings that control the behavior of the cursor, default printing margins and 
the number of recent files to include in the Recent files list. 
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Customize 
Ribbon 

Contains tools you can use to customize the Ribbon. 

Quick Access 
Toolbar 

Contains tools you can use to customize the Quick Access Toolbar. 

Add-ins Contains options that allow you to view and control Microsoft Office add-ins. 

Trust Center Contains links to privacy statements and a command button that opens the Trust 
Center, which controls security settings for Access. 

 

Learn the Skill 
In this exercise, you will set options on various tabs of the Access Options dialog box. 

1 Restore the Access window. The HomeGrownSample database should be open. 

2 Switch to Backstage view, then click the Options command to open the Access Options dialog box. 

3 Click the General tab if necessary. 

  

4 In the Creating databases section, click the Browse button to open the Default Database Path dialog 
box. Navigate to the Desktop\3255 Student Files folder, then click OK to set the default path to the 
Student Files folder on the desktop. 

5 Click the Current Database tab, and then select the Compact on Close checkbox. (You will learn 
about compacting and repairing in Lesson 6.) This option is set only for the current database 
(HomeGrownSample.accdb). 
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6 Click the Datasheet tab. Note the default font size and weight, and that both horizontal and vertical 
gridlines display in Datasheet view. 

  

7 Click the Object Designers tab, then change the value in the Default text field size to 50. The field size 
affects how much space a database will require. (You will learn about field sizes in Lesson 2.) 
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8 Click the Client Settings tab, then scroll the screen and examine each of the settings. These settings 
control how the Access application behaves on your screen under various conditions. 

  

9 Click the Trust Center tab, click the Trust Center Settings button to open the Trust Center settings 
screen, then click the Trusted Locations tab. You can use the Trusted Locations tab to specify folders 
from which you trust files. If you make a folder a trusted location, you can open any database within 
that folder without receiving the security warning from Access. 
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10 At the bottom of the tab, click the Add new location button to open the Microsoft Office Trusted 
Location dialog box. The location listed in the Path box is where the Access database wizards are run. 

  

11 Click the Browse button, navigate to the Desktop\3255 Student Files folder, then click OK. Select the 
Subfolders of this location are also trusted check box, then click OK to make the Student Files folder 
(and its subfolders) a trusted location. 

12 Click OK to close the Trust Center, then click OK again to close the Access Options dialog box. If a 
message saying that you must close and reopen the current database for the specified option to take 
effect displays, click OK to close the message box. 

13 Close the open database, then click the Close button at the upper-right corner of the application 
window to quit Access. If necessary, click Yes to confirm that you want to empty the Clipboard. 

14 Start Access, click the Blank desktop database template in the template gallery. In the dialog box that 
opens, notice that the suggested path is to the Desktop\Student Files folder. This is now the default 
path for saving files. 

15 Close the dialog box without creating a new database. 

16 At the bottom of the Recent files list, click the Open Other Files link to access the Open tab in 
Backstage view. 

17 In the middle section, click Computer, then in the folder list section, click Browse to open the Open 
dialog box. 

18 Navigate to the Desktop\3255 Student Files\Lesson1 folder and open the TrustMe database. The 
database opens without a security warning because it comes from a trusted location. 

19 Close the Trustme database, then quit Access. 
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Lesson Summary 
In this lesson, you used the Access 2013 user interface and learned to use them to create new database files, 
and open and save files. You worked with the Navigation Pane, exported data and set Access options. You 
should now be comfortable with: 

 defining the function of a database 

 comparing databases in spreadsheets to those 
created in a relational database management system 
(RDBMS) 

 identifying Access file types and file name extensions 

 identifying database objects 

 differentiating between desktop databases and 
Access Web apps 

 identifying the main components of the Access user 
interface 

 identifying elements on the screen  

 creating new blank databases 

 creating databases in older formats 

 creating databases from templates 

 opening and closing databases 

 working with the Navigation Pane 

 saving and exporting databases 

 setting Access options 

Review Questions 
1. Which of the following is a benefit of storing data in multiple, related tables?  

a. It makes the tables easier to understand when you view them in Datasheet view. 

b. It minimizes the repetition of data. 

c. It makes the database larger. 

d. It makes the data accessible by all versions of Microsoft Access. 

2. Which of the following types of database objects is often used as a data entry screen?  

a. A query. 

b. A report. 

c. A macro. 

d. A form. 

3. The commands and options in Backstage view are related to:  

a. file management tasks. 

b. entering data into tables. 

c. relating tables to one another. 

d. automating tasks within a database. 

  

MMM 
Go online for Additional Review and Activities 
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4. What does the globe icon in the template gallery indicate?  

a. The template is available in over 70 languages. 

b. The template will work in all versions of Microsoft Access. 

c. The template is for a web app. 

d. The template was developed by Microsoft and Google. 

5. Which of the following is the native file format for Access 2013 databases?  

a. .mdb 

b. .accdb 

c. .db 

d. .sql 
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